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Contact and Support Information
Return to Table of Contents.

Product and account information can be accessed by visiting Customer Support online at
Support.CCH.com/Axcess. In addition to product and account information, the Customer Support site offers
answers to our most frequently asked questions, forms release status, Knowledge Base articles, training
videos, and operating systems compatibility for each CCH Axcess module. Access to these features is
available 24/7.

The following Web site provides important information about the features and updates included in all CCH
Axcess Tax releases: Release Notes

Visit the Application Status Web page to view the current status of our CCH Axcess applications. The
Application Status Web page is updated every 15 minutes.

Go to Contact Us to find Support calendars, as well as options to enter Web tickets for assistance.
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Information in Tax Year 2014 Release Notes
Return to Table of Contents.

CCH Axcess Tax Release Notes inform you of the enhancements and updates that have been made to Tax
products and systems with the current release.

The updates provided in the Release Notes include the following:

Contact and Support information
Updates to Tax technology (electronic filing updates, Organizer, roll forward, technology
enhancements)
Updates made to Tax products (form additions and updates, changes in diagnostics, changes
caused by regulatory updates)

To access a list of CCH Axcess Tax Release Notes for the current year and for prior years, visit the Release
Notes page on our Customer Support site.
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Highlights for Release 2014-3.4
Return to Table of Contents.

2014 Tax Updates

Individual
New York

NY Form IT-222, General Corporation Tax Credit, is now available, including for electronic filing.

Philadelphia

Philadelphia net taxable resident or nonresident losses are correctly reported in the electronic file as
negative amounts; the bottom line result in the electronic file remains correct. Philadelphia's secondary
accuracy check will no longer report a mismatch resulting in a potential notice.

Beginning on Monday, April 27, 2015, you will be prompted to update to version 2014-3.4 in order to
electronically file a Philadelphia return.

Partnership
New York City Electronic Filing

Prior to version 2014-3.4, if an extension was electronically filed and the balance due was paid by check,
the old address was incorrectly shown on the extension transmittal letter and extension filing instructions
(P.O. Box 5070, Kingston, NY 12042-5070).

With the release of version 2014-3.4, the mailing address for NYC-EXT voucher NYC-200V, will now show
the new address (P.O. Box 3646, New York, NY 10008-3646) on the extension transmittal letter and
extension filing instructions.

If the payment and voucher NYC-200V has already been mailed to the incorrect address (P.O. Box 5070,
Kingston, NY 12042-5070), then it may be returned to the sender.

Should this situation apply to your client, the NYC Department of Finance recommends that the following
steps be taken:

1. Keep the original envelope with the old address and Post Office cancellation date.
2. Send the payment and voucher NYC-200V to the correct address (P.O. Box 3646, New York, NY

10008-3646), as soon as possible.
3. If the taxpayer is charged a late fee, they will receive a notice that includes a phone number

they can call at the NYC Department of Finance. At that time, a request for the late fee to be
waived should be made.

Corporation, S Corporation, Partnership
Iowa - Form IA 136, Iowa Fuel Tax Credit for Fiscal Year filers is now available for processing Illinois. A
form is now available for processing called Additional Electronic Filing Information. This form is used to
provide additional information to Illinois and include it in the electronic file.
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Fiduciary
New York returns with multiple sets of bank information with the first coded for federal only and a
subsequent coded for state only with NY as the state, coupled with no selection for direct debit or direct
deposit, no longer indicate the amounts will be debited or deposited to the specified bank account in the
direct debit/deposit report, diagnostics, and letters or filing instructions. Previously, the direct
debit/deposit report, diagnostics, and letters and filing instructions indicated the account would be used,
but no deposit/debit was included in the New York electronic file. A scan will be available to identify
impacted returns.

2014 Electronic Filing
The following state returns are approved and available on this release:

Fiduciary

Illinois
Ohio
Pennsylvania
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Tax Product Updates

Individual (1040) Product Updates
Return to Table of Contents.

Federal
Federal Alternate Filing Instructions. When interest and penalties exceed the amount of refund or
overpayment applied on Form 1040, Lines 76a and 77, the Alternate Filing Instructions will now include a
breakdown of the tax, payments, penalties, and overpayment as well as the amount of overpayment applied
and refund.

Form 1116, Part II, (h) and (i), paid or accrued boxes, are checked independently from the information for
paid or accrued on Form 1116 AMT.

Form 114. Line 45, includes the Filer's title entered on 114 and 8938 - Foreign Assets > Form 114 Filer
Information > Filer's title.

Form 3520-A. Lines 2(a) through 2(e), are filled out when Line 2, No, is checked, regardless of whether
Form 3520, Line 13, Yes, is checked.

Tax Equalization. Hypothetical Form 8801, Line 40, uses the prior year rates rather than the current year
rates.

Tax Equalization. New fields have been added to allow the foreign taxes paid or accrued to be excluded
from the hypothetical calculation of Form 1116 on Credits > Foreign Tax Credit > Part II-Foreign Taxes Paid
or Accrued > No Hypo.

Tax Equalization. Reconciliation for MN actual state tax liability is reduced by nonrefundable credits.

Electronic Filing
1040NR returns containing tax equalization can export the state returns without manual input modifications.

Alabama
Form 8453-B, Line 4, matches the balance due as shown on Form PPT in all situations.

When electronic withdrawal is selected for Alabama, and then removed, Form 40V generates.

Alabama Electronic Filing
The electronic filing program has been corrected to prevent reject ALPPT-097.

The electronic filing program has been corrected to prevent reject ALPPT-304.

Arizona
Underpayment penalty carries when Form 221 is forced.

Arizona Electronic Filing
Arizona Form 8879 produces for nonresident and part-year resident filers.
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Arkansas
A statement is available for AR1000NR, Line 14, for Arkansas source capital gains.

Only Arkansas source capital loss carryovers will be produced for the Carryover to 2015 report.

Form AR1000NR, Line 18, includes amounts from the Federal Schedule E without adjustment for bonus
depreciation.

Arkansas Electronic Filing
Form AR1000 Page 4 (Schedule AR4), no longer includes nondeductible amounts of bond premiums allocated
to bank interest when tax-exempt interest is greater than bank interest.

California
For part-year and nonresident returns, the Form 540ES Worksheet, Line 17, only calculates when California
Source AGI is greater than $1,000,000.

Form 568, Line 6, includes the amount from the prior year Form 3522, even when this form is suppressed.

Form 568, Schedule B, Line 7, calculates correctly when Form 568 is attached to a Federal Schedule F.

Form 8543-LLC, Part V, Title field, fills from Single Member LLC information input.

Schedule CA, Line 9b statement correctly reflects the amount on the schedule.

The spouse social security number flows to Form 3840, when appropriate.

Delaware
Form 200-ES 5E references October 15, 2015.

Form 200-ES 5E scan line reflects the correct tax year.

Delaware Electronic Filing
Schedule W, Page 2, foreign address location, fills when a date range is entered.

District of Columbia
Deductions entered on Federal Schedule E flow to Form D-30, Schedule G.

Form D-40, Calculation F, Line b, picks up the pro rata share of state/local tax when the itemized
deductions are limited.

State bonus depreciation differences on Form 2106/SBE attached to a K-1 entity are included on Schedule I,
Line 3.

The State Extension letter includes the amount to be submitted that is appearing on the FR-127.

Georgia
Business credits 102 , Employer's Approved Employee Retraining Credit, and 105, Employer's Credit For
Providing or Sponsoring Child Care For Employees, are limited to 50% of tax liability, before applying any
other credit.

CAF number no longer prints on Form RD-1061, Part 7, Bar Licensing column.
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Credit number 132, Qualified investor tax credit, prints on Form 500, Page 5, Schedule 2, Line 6,
passthrough credits.

Form 8453 prints the personal representative's address for a deceased taxpayer when entered in the return.

More than one record is allowed to be entered on the Georgia > Credits worksheet section for Form IT-QEE-
TP2, Part B.

Qualified charitable contributions deducted on Federal Form 1040 are not added back on Form 500, Page 4,
Line 4, as other additions to income.

Illinois
Schedule M, Line 13, does not include any distributive share of river edge redevelopment zone and high
impact business dividend subtractions from a partnership, S corporation, trust, or estate.

Schedule NR, Line 37, includes the moving expenses on Line 25 when the federal 1040NR is generated.

The Base Employment Calculation Worksheet generates when the business is not new to Illinois.

Kansas
Kansas form 8960, Line 21, calculates correctly when Line 20 is present.

Schedule S, Part B, Line B17, shows the student loan interest paid if the student loan interest paid is being
limited by the taxpayer's AGI on Form 1040, Line 33.

Louisiana Electronic Filing
Form NRA for nonresident professional athletes includes new requirements, as defined by Louisiana.

Maine
Schedule 1 Worksheet, Line 3, excludes ME Public Employees Retirement System Pick-Up Contributions paid
in the calculation of the pension exclusion.

When Lines 1 and 6b of 1040ES-ME use Federal Estimated Tax Worksheet, Line 1 of 1040ES-ME will use this
federal amount. Line 6b of 1040ES-ME will use the federal exemption amount for 2015.

Maryland
The Maryland Return Summary reflects correct estimate payments when the option to not carry the
extension payment automatically to the return is selected.

MD is not listed on the extension report if Form 502E is not printing.

Maryland Electronic Filing
Disqualifying diagnostic 42390 does not issue when amounts with pennies have been entered on W-2s or
1099s in the return.

Disqualifying diagnostic 46419 issues if Form 502, Line 22, Maryland tax, does not match the amount from
the tax tables or tax computation worksheets.

Massachusetts Electronic Filing
The percent of ownership on Schedule SC is rounded to 2 decimal places to prevent Reject 0047.
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Michigan Electronic Filing
Diagnostic 48159 issues to prevent export when Schedule CR-5 Agreement Expiration date is prior to the
current tax year or greater than 90 years from the current tax year.

Minnesota
Form M1MTC, Alternative Minimum Tax Credit, Lines 26 and 27, do not limit to zero when negative, which
also resolves rejects 0233 and 0879.

Form M1, Individual Income Tax, Line 5, state income tax refund, fills for all reciprocating returns, which
also resolves disqualifying diagnostic 41513.

MN State 8960, Net Investment Income Tax, includes all state taxable exempt-interest dividends on Line 2.

Missouri
Form ST 8960, Lines 13,16, and 19 calculate using the correct taxpayer and spouse coded entries.

Missouri - Kansas City
The FEIN/SSN line on RD-111 and RD-111S now allows for more characters.

Montana
Form MT2, Line 47, calculates the spouse's 2% capital gains tax.

New Jersey
NJ 630 produces, if necessary, when the option is selected to suppress print of all extensions in the return, if
not required.

NJ 8960, Line 10, white paper statement reflects the amount for ST 8960, Line 10.

New Mexico
Credit for taxes paid calculates when New Mexico source income is higher than total federal income due to
losses from pass-through entities.

The date will fill in the space provided to indicate when the extension of time to file a return is requested
on form RPD-41096.

New York
Form POA-1, Section 8, prints Other when using Designation Code M and will print multiple descriptions.

Form IT-201-V reflects the amount due on Form IT-201-X.

Form IT-360.1, Line 29, includes calculation for high income phase-out of itemized deductions.

The following New York form is available: Form IT-222.

New York Electronic Filing
Form IT-203-B, Schedule B, will print on the first line when there is room to print the description.

Form NYC-208, Step 2, is filled out when the customer has over $85,000 in real property in New York.
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The taxpayer's name does not print on Form TR-579.1-IT if the taxpayer is deceased.

North Carolina
Charitable contributions are not added to Schedule S, Line 20, as North Carolina source income for part-year
and nonresident returns.

For North Carolina separately filed returns, Schedule S, Line 20, North Carolina sourced income, includes all
North Carolina income that is coded T on the Income/Deduction > Nonresident and Part Year Information >
North Carolina source income code field.

State income tax payments on Form 8960, Line 10, match the statement when more than one estimate
section or sheet are entered.

Carolina > Income/Deduction > Nonresident and Part-year Information > North Carolina source income code
field.

North Dakota
Form ND-1V will not be present in a return with $0 due when there is no balance due on Form ND-1, Line 33.

Ohio
Filing instructions and transmittal letters show the correct ZIP code for the IT 1040.

Form IT 1040X, Line 19, correctly calculates.

IT 1040X, Line 16, is limited to zero.

The direct deposit/debit report shows the correct amount of the debit when an amount to withdraw is
entered and is greater than the balance due.

Oregon
Form ST 8960, Line 15, calculates when a nonresident or part-year return is being filed.

OR 40, Line 33, does not limit the exemption when the taxpayer, spouse, or child is disabled.

Subtraction codes 335 and 350 are now available for selection.

Tuition and Fees deduction is limited according to income.

Pennsylvania
Joint coded K-1 entities do not double on Schedule B, Line 9.

Pennsylvania - Philadelphia Electronic Filing
Electronic filing of forms BIRT, BIRT-EZ and NPT use the taxpayer's last name when the spouse's last name
has not been entered.

Philadelphia
The Net Profits Tax and Business Income & Receipts Tax > Income/Deductions > Gain on sales of stocks,
bonds, capital assets, etc - override field has been added to reflect the amount entered on PHI3, Box 53.

Form ENP-1, Line 2, uses overpayment from NPT, Page 1, Line 10, and Form ENP-2 uses overpayment from
ENP-1, Line 3.
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The mailing address ZIP code for balance due BIRT/BIRT-EZ and NPT returns is 19105-1393.

South Carolina
Schedule NR, Line 19B, includes self-employment income from passthroughs.

Schedule NR, Line 47, has been updated to not limit Line 47 to the Federal exemption phase-out.

Utah
Federal income flows to the TC-40, Line 4, from the 1040 regardless of whether they are filing a Form 1040
or a Form 1040NR.

Vermont
Schedule IN-112, Part 3, VT Earned Income Credit, for part-year residents, Lines 3-9, are blank and Lines A-
C are answered zero and no if Line 9 is not greater than zero.
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gPartnership (1065) Product Updates
Return to Table of Contents.

Federal
Form 4797. Asset dispositions that should not be included in self-employment income will no longer be
included in the calculation of self-employment income on the multiple activity schedule.

Custom filing instructions for the Massachusetts Form NRCR and 1-ES will now produce when the income
reported on the NRCR is negative.

Form 8825. Disallowed rental expense carryover amounts are not allocated to the personal portion for
vacation home rentals.

Form 1065, Schedule K. Line 20e was updated to clear any data when the input is removed.

Schedule K-1 letters are all partners only when the return configuration set option to produce Schedule K-1
Transmittal letters is selected or when the Federal > Partners > Schedule K-1 Transmittal Letter > Print
Options > Produce the Schedule K-1 Transmittal Letter field is set to Yes.

Form 4562. The accounting for Section 179 from rental real estate activities was updated to better reflect
the book/return amounts.

Form 1065, Schedule M-1. The Current year increase (decrease) line on the form was updated to match the
statement by excluding meals and entertainment as part of nondeductible expenses when the Other
miscellaneous expenses on Schedule M-1 override is used.

Filing instructions. The custom filing instructions will reflect that the Make Check Payable To section is Not
applicable when there is no balance due.

Form 1065, Schedule K. The diagnostic for an invalid foreign country of financial institution has been
updated to disallow code UM.

Form 1065, Schedule K-1. The export of foreign entity data was fixed to ensure the correct data exports
from the 1065 return and imports into the correct place in the 1040 return.

Form 4562. The presentation of unused Section 179 carryover has been improved when carryover exists from
the trade and business and passthrough entities in a single return.

The trade and business, other deductions worksheet, will populate even if there is no trade or business entity
present.

The worksheet for portfolio deductions subject to the 2% floor now includes non-deductible portfolio
deductions.

When multiple change codes are present on Form 3115, the presentation of some descriptions has been
modified per IRS specifications.

When the balance sheet is to be adjusted for current year sales of depreciable assets and there are no
current year sales of depreciable assets, we no longer add current year asset purchases to the depreciable
assets.

Alabama Electronic Filing
The supporting PDF for Form 65 Schedule K, Line 11, will now be auto-generated and attached to the return
when Schedule B, Line 1h, is populated.
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Electronic filing disqualifying diagnostic 41433 now issues correctly for Schedule K, Line 16, computational
errors.

Electronic filing disqualifying diagnostic 47637 will no longer issue for Form BPT-E when multiple test
entries are made as long as one of the tests' percentages is at least 90%.

Electronic filing disqualifying diagnostic 49109 will now issue for Form 65 when missing the PDF statement
supporting Schedule A, Line 16, and Schedule K, Line 9.

Form 65, Form PTE-C and Form PPT check boxes for Calendar Year , Fiscal Year, and Short Year return
types are now automatically marked appropriately based on dates entered for the tax year.

Form PPT Apportionment Worksheet electronic filing disqualifying diagnostics 46258, 46257 and 46256 will
no longer issue when taxpayer type is a Disregarded Entity that is subject to tax.

New Electronic filing disqualifying diagnostic 48704 will issue for Form PPT when the taxpayer type is a
Disregarded Entity that is subject to tax and Part A, Line 10, is not an FEIN.

Alabama
Form PTE-C payment voucher PTE-V is now referenced correctly in the transmittal letters.

Arizona
Printing of K-1 copy no longer includes supporting statements for the Form 140NR, behind the Schedule K-
1NR of the first partner.

Arkansas
AR1099PT will match the partner numbers entered on the Partners > Partner Information worksheet.

California
Depletion worksheets will print behind each applicable state when California is present in the return.

Form 3536 transmittal letter and filing instructions will reflect the correct due date when the return has a
52/53 week year.

Form 4684, Lines 23 through 38, will populate when there is a casualty gain. The casualty gain reported
from rental real estate activities will flow to Form 8825, Line 19.

Form 540-ES will not be referenced in the filing instructions and transmittal letters when it is suppressed.

Nonresident withholding forms will not be suppressed when California > General Information > Single
Member LLC (568 Only) > Suppress forms for a disregarded entity is selected.

Schedule K-1 (565), Table 3, Line 2, will be cleared if the partner type is changed to a type where the line
is no longer applicable.

Schedules K and K-1, Line 15a, will reflect the amount on Form 592-B when the total CA tax withheld -
override from California > Nonresident Withholding > Basic Data is used.

Section 1231 gain or loss overrides entered on California > Income / Deductions > Schedule K Other
Adjustments / Overrides can be specially allocated without entering the CA source amount.

California Electronic Filing
Upper case can now be used when filing a return with Form 592-B.

Tax Product Updates • 13



Connecticut
The extension will no longer show as being ready to release on the electronic filing status system when
there is no extension present for Connecticut.

Hawaii
A statement will generate behind Form N-312, Line 2a, when more than four occurrences are present. Form
N-312 will no longer produce for this scenario.

Form N-318, Part II, Line 7, has been revised to produce a statement to show detail of the amounts that
make up the total reported on Line 7.

Schedule D-1, Part II, Line 15, has been revised to always deduct or add the correct amounts with the use of
Columns g and h.

Schedule D-1, Part II, Line 16, has been revised to use the amounts from Federal Form 6252.

Schedule D-1, Part II, Lines 5 and 17, have been revised to always deduct or add the correct amounts with
the use of Columns g and h. Statements for Lines 2 and 11 have also been revised to no longer show Form
8824 amounts due to the fact that the amounts are already accounted for on Lines 5 and 17.

Schedule K-1, Line 10, has been updated to equal the amount on Form N-20, Schedule K, Line 10.

Illinois
Schedule 1299-A, Lines 17 (Enterprise Zone Investment Credit) and 20 (River Edge Redevelopment Zone
Investment Credit), will always have a statement.

Indiana
Form WH-18 will now display payer overrides entered on the Indiana > WH-18 Payer overrides worksheet.

Schedule K-1, Line f, will no longer print the composite tax for the partner when the partner is being
excluded from the IT-65COMP.

Schedule K-1, Lines 1 and 8, can be specially allocated using special allocation codes on the Special
Allocations > Special Allocations Detail worksheet.

The IT-6WTH payment information has been added to the transmittal letter and filing instructions.

Iowa
IA4562A, Column G, will now include bonus depreciation as part of the accumulated depreciation total.

Kansas
Form LC -50, Line 6, Name and address of each member who owns 5% or more of capital, will now create a
statement anytime the State of Organization is Kansas.

Kentucky
Oil and Gas expense adjustments will use the same calculation as federal, and then make the comparison to
get the adjustment.

Schedule K, Section I, Lines 4D and 4E, will include Portfolio short-term gains and losses. All other Schedule
D gains and losses will be on the Other Income line of Schedule K and a statement will be provided.
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Kentucky Cities
Letters and filing instructions for Form 228 will show net amount of Form 228, Lines 10 and 11.

Kentucky Property Tax Returns
Form 62A500 Misc LFM worksheet will populate the Class 3, Year 5 when those entries are present.

Louisiana Electronic Filing
When a shareholder has a US state for the mailing address and foreign country as a residency code, the
Partners > Partner Information (Detail) > Basic Partner Data > State code field/foreign country code,
Louisiana will treat the shareholder as having a US address and there will be no schema validation error.

Massachusetts
Massachusetts Form 3, Lines 29 and 30, can now be adjusted by making entries on the Interest > Interest
Income (Detail) > State 1 amount field. If the home state is MA, the interest is assumed to be MA sourced
and reported on Form 3, Line 29. An entry in the State 1 field will subtract that amount from Line 29 and
will be added to Line 30.

Massachusetts Schedule 3K-1, Line 25 for Corporation and S Corporation partners, will now deduct the
Section 754 depreciation when the override is entered on the Massachusetts > Income/Deductions >
Separately Stated Deductions and Other Adjustments > Section 754 depreciation - override (Total) field.

Michigan
Form MI 807, Line 44, the Percent of income attributable to Michigan will no longer default to 100% when
the amount on Line 42 divided by the amount on Line 43 results in a negative percentage.

Form MI 807, Line 5 amount will be the same as the amount of the Federal Form 1065, Page 1, Line 22.

The Form MI 4918, Schedule K-1 equivalent, Line 6, Income attributable to other Michigan flow-through,
will be allocated to the partners based on the partner's default percentage for special allocation of ordinary
income components rather than the profit and loss percentages when ordinary income components have
been specially allocated.

Michigan - Grand Rapids
Michigan Cities Common Form. Schedule K-1, Part IV, will now list the estimated tax paid by the partnership
on Line D and the tax paid by the partnership from Schedule 2, Column 2, on Line T.

Michigan - Port Huron
Port Huron will no longer use Grand Rapids information for Schedules B1 through B10.

Minnesota Electronic Filing
Disqualifying diagnostic 45100 will now issue when the partner's foreign postal code or ZIP code is all zeros.

The MN electronic file will no longer get a schema validation error on Schedule KPI when the entity is
classified as FOREIGNUS for electronic filing.
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Montana
Schedule III was not properly allocating partners' distributive shares. The form will now use the correct
inputs and calculate the shares accurately.

New Hampshire
Filing Instructions for DP-10, Interest and Dividends Tax Return, for when the form is being electronically
filed have been updated to not say Return NH-PYT to us by.... for the payment voucher, when a code is
entered on the General > Letters and Filing Instructions worksheet >General Letter Information > Due date
of electronic filing form code field.

Form NH-1120-WE, Combined Business Profits Tax Return, Lines 11(b) and 12(a) - 12(l), have been updated
to also pull Partnership, S Corporation, Fiduciary, and Individual information into the combined return.

The state has changed the P.O. Box number from 637 to 1265 on Form NH-PYT, Payment Voucher.

New Hampshire Electronic Filing
PDF attachments have been updated to NOT include the PDF for New Hampshire when the General >
Electronic Filing > PDF Attachment - Optional > Columns FS and State codes are blank, New Hampshire is
not the Home State, and the General >Electronic Filing > General Information and Qualifications > NOT
transmit federal return or extension field is selected.

New York
Form IT-204CP, Lines 77 through 79, will now only show if codes 107, 108 and 109 are on Form IT-204, Page
8, Lines 147a through 147h.

Form IT-204IP will leave Section K, Residency Status Blank on all types. This is being done in accordance
with Form IT-104IP instructions.

Form IT-2105MN will no longer apply the overpayment from Form MTA-505 as Form MTA-505 overpayment
must be refunded per New York.

Forms IT-204IP and IT-204CP should no longer show estimates if there are no Forms IT-2658 or CT-2658
present.

New York Electronic Filing
Disqualifying diagnostic 47718 will issue to prevent reject 1062.

Disqualifying diagnostic 47719 will prevent electronic filing with the Brownfield credit.

Disqualifying diagnostic 47720 will prevent rejects R1054, R1055, and R1056.

New York City Electronic Filing
The mailing address for NYC-EXT voucher NYC-200V will now show the new address (P.O. Box 3646, New
York, NY 10008-3646) on the extension transmittal letter and extension filing instructions. When the
extension is electronically filed and the balance due is to be paid by a check, the old address was
incorrectly shown on the extension transmittal letter and extension filing instructions (P.O. Box 5070,
Kingston, NY 12042-5070). If the payment and voucher NYC-200V have been mailed already to the incorrect
address (P.O. Box 5070, Kingston, NY 12042-5070), it may be returned to the sender.
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When this is the case, as per our contact with the NYC Department of Finance, the following steps should be
taken:

1. Keep the original envelope with the old address and Post Office cancellation date.
2. Send the payment and voucher NYC-200V to the correct address (P,O. Box 3646, New York, NY

10008-3646) as soon as possible.
3. If the taxpayer is charged a late fee, they will receive a notice that includes a phone number

to call the NYC Department of Finance. At this time, a request for the late fee to be waived
should be made.

Ohio
Form IT-4708, Pages 5 through 7 (Investor Information), now include the investors' last names at the
consolidated level (shell return).

Form IT SBD, Part I, Line 6, now includes the correct amount for Section 168(k) and qualifying Section 179
expense amounts.

The extension payment input under Other > Extensions > Ohio (Form IT 1140) Extension has been added.

Oregon
The Oregon source depreciation override will now accept zero, allowing preparers to eliminate their Oregon
source depreciation on the Schedule K-1.

Pennsylvania
In certain circumstances, the Pennsylvania REV-799 Sch C-3 will populate with information even if no
Federal Bonus Depreciation is present.

Rhode Island
A new option, Rhode Island > Income Deductions > Schedule B, Schedule C and Adjustments to Income >
Section 179 depreciation already deducted on federal return but not yet deducted on Rhode Island Return,
has been added to provide a way for you to designate depreciation from Section 179 Expense not allowed in
state for prior years.

The Annualized Income Installment Worksheet number on RI-2210C now flows into RI-2210C, Page 1 Line 15.

Rhode Island Electronic Filing
Disqualifying diagnostic 45503 will issue if there is a principal location listed on Form 1140 and no principal
state has been entered.

Forms RI-1065 and RI-1120 electronic files will now populate up to 27 states from Schedule G, List of states
to which you are liable for income or excise taxes for the taxable year. The paper return will now provide
a statement for entries greater than what is available to print on the form.

Texas
The issue of Texas Franchise Tax Reports with a foreign mailing address for partners listed on the 05-167
causing a schema validation error has been fixed.
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Vermont
A special allocation code of 48013 has been added for bonus depreciation.

The option to prepare all Schedule K-1VT forms has been added to the Vermont > State Worksheets >
Composite worksheet section.

Virginia Electronic Filing
Schedule VK-1. Disqualifying diagnostic 43607 will issue when a negative amount is entered for other
additions or subtractions.

Wisconsin
Partners can be added to Form PW-1 by entering their partner number on the Federal > Partners > Wisconsin
worksheet section.

Schedule 3K-1, Line 22, Column e, includes investment expenses listed on Line 13, Column e, and does not
include those amounts if they are included on Line 20, Column e.

Wisconsin Electronic Filing
Form A-1, Line 17, the apportionment percentage, will now be included in the electronic file whenever a
sales amount is present.

Form PW-U will calculate regardless of whether overrides for underpayment are used for Form PW-1 on the
Wisconsin > Credits > Nonresident Withholding worksheet section > field 17.

If both the state field and the country field are filled on the Federal > Partners > Partner Information
worksheet section, then unless the entry for state is FC or the code for a foreign province, the address on
Schedule 3K-1 will be considered as a US address.

Partners with a state code that is either FC or a foreign province on the Federal > Partners > Partner
Information worksheet section are considered to have a foreign address for Schedule 3K-1, Form PW-1, and
Form 1CNP.
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Corporation (1120) Product Updates
Return to Table of Contents.

Federal
The 1120 Transmittal Letter was updated to ensure the appropriate electronic filing paragraph will always
issue.

The bottom margin for the cover letter has been raised one line to prevent letter text from the printer
overwriting the accountant's footer.

When doing an elimination company consolidated return, the elimination company will no longer appear on
the affiliate statement attached to Form 7004.

Direct Deposit/Debit Report
The Direct Deposit/Debit Report will now show Form 1120-F refund amount only when Form 8302 is
activated in the return.

Alabama
Form CPT transmittal letter now shows the mailing address for returns with no balance due.

Alabama Electronic Filing
Electronic filing disqualifying diagnostic 49709 will now issue for Form CPT with Taxpayer type F when the
apportionment factor is less than 100% and the required PDF is not in the return.

Form BPT-NW, Line 29 statement for retained earnings, will be produced when there are negative amounts
entered.

New electronic filing disqualifying diagnostic 48695 will issue when Form CPT, Schedule G, consolidated
election check box is marked and an invalid amount appears on Form CPT, Line 5.

Arizona
Input is now available on the Federal Other > Extensions > State / City Extension Information Line 25 -
Special use - MTA or Other Form column to fill Form AZ 120-EXT, Line 4 (extension amount paid
electronically).

California Combined
A new warning message has been added to the Federal Reconciliation method combined return preparation
to alert the preparer that they have made an unallowed entry. The new message is displayed when the
preparer enters California membership different than what was entered at the federal level. The new
message is An entry is not allowed in this field when using the Federal Reconciliation method of return
preparation.

Colorado Electronic Filing
The Colorado marijuana deduction will no longer allow a negative value.
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Connecticut
A statement has been installed for capital loss to support the amount on Form CT-1120 page 2, Schedule D,
Line 12.

Form CT-1120CC-R is now available for standalone corporations that are no longer included in the
consolidated group.

Florida Electronic Filing
Form FL2220 will now use payments not based on income when computing the interest calculation.

The extension has been updated to display short year on the Electronic Filing Status system.

The PDF report will now display Florida PDFs when they have been selected for state and Florida.

The transmittal letters and filing instructions will no longer reference signing the Form F-851 when the
consolidated return is being electronically filed.

Hawaii
Schedule D-1, Part II, Line 15, negative ending amounts have been revised to show in Column g (LOSS) as a
positive number instead of in Column h (GAIN) as a negative number.

Illinois Combined
Schedule UB/NLD. When Line 6 (or 12, etc.), Column E, is negative, Line 8 will be negative.

Indiana
Form IT-20X, Line 12c, will now include the Edge and Edge R refundable credits.

Iowa Electronic Filing
IA148, Part II, has been updated to include credit forms IA 128 and IA 128S when part of a consolidated
return.

Kansas
Form K-120, Part I, Line 2, High Performance Incentive Program Credit, will now include the total of Form
K-59, Line 9, amount of credit allowable, and Line 13, amount of credit available, if both are present in the
return.

Kentucky Electronic filing
A disqualifying diagnostic will be issued when an override is used for Form 4562, Line 1 or 5.

When there is direct debit requested for Kentucky, and then Massachusetts, New Mexico, and Tennessee
direct debit information will now be included with the electronic file.

New Hampshire
The state has changed the P.O. Box number from 637 to 1265 on Form NH-PYT, Payment Voucher.
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New York Electronic Filing
Diagnostic 57418 will issue when the filer city is missing.

New York City Electronic Filing
The electronic filing extension signature on Forms NYC-579-GCT and NYC-579-BCT will now print when
extensions are selected from the Print Menu.

Wisconsin
Diagnostic 48722 has been added for non-combined returns containing Form N with no total on Line 14.
Diagnostic 48723 has been added for combined returns containing Form N with no total on Line 14.

Form A-2 prints properly when entries are made that calculate as zero percent.

The prior year carryforward amounts for the Pre-2009 sharable net business losses now calculate per state
instructions. Additional input is available for companies in a combined group with no prior net business
losses on Form 6BL to enter the income for sharing the prior year Pre-2009 net business loss. The input is on
the Federal > Income/Deductions > NOL Carryover/Carryback (Detail) > State Carryover Information
worksheet section in the Taxable Income (loss) field with a code of WI in the state field and the year the
income originated on in the year field. The input must be made in the parent or subsidiary return.

Wisconsin Electronic Filing
Diagnostics 48681 for combined returns and 47136 for separate company returns will now appear if there is
a Schedule CF for carryforwards of unused credits in the return that are missing either the year or the
original amount of credit calculated for a year.

Form 6 return group with a member whose taxable year end day is a single digit (1 through 9) will now
validate.

Form A-2 Telecommunications total apportionment percentage is now sent into the electronic file if the
value calculates as zero.
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S Corporation (1120S) Product Updates
Return to Table of Contents.

Federal
Depletion from non-oil and gas properties is no longer included in percentage depletion, when exported.

Disallowed rental expense carryover amounts are not allocated to the personal portion for vacation home
rentals.

Tentative oil and gas depletion from passthrough entities is no longer deducted from book income (loss) as
computed on Schedule M-3.

The new Tax Balance Summary has been added for Federal S Corporation. This is similar to the Tax Balance
Summary, which currently exists in the 1120 program. This new tool presents at a glance if key amounts
within the return reconcile with one another and are in balance. As an example, amounts such as Total
Assets to Total Liabilities and Equity are compared; taxable income (loss) per Schedule K to taxable Income
(loss) per tax return on Schedule M-3, Part II, Column D, are also displayed. If a difference exists, it is shown
in the difference column of the Tax Balance Summary. When a zero appears in the difference column, it
indicates the amounts are in balance. For a consolidated return, a Tax Balance Summary will be produced
for each member at the consolidated level. The Tax Balance Summary may be accessed from the
Government View tree/list. It is located after the Return Summary and before the Direct Deposit/Debit
Report. The Tax Balance Summary will always be highlighted and present in the Federal Government View
tree/list; however, it will not automatically print. To print it in the Accountant's copy only, make an entry
in the Return summary and tax balance summary option field on the General > Return Options worksheet.

Electronic Filing
1120S, Schedule M-3 diagnostic 48319 will no longer issue when Pages 2 and 3 of Schedule M-3 are
suppressed.

Alabama
The Form PPT 2D bar code has been updated per state specifications.

Alabama Electronic Filing
Electronic filing disqualifying diagnostic 46899 will not issue for a rounding difference on Schedule K, Line
9, and Schedule K-1, sum of all T lines.

Electronic filing disqualifying diagnostic 47567 will now issue if there are multiple PDFs for retained
earnings supporting Form BPT-NW, Line 29.

Form PPT now prints in the government copy when indicated on the Electronic Filing > General > Print
entire government copy of electronic return field.

New electronic filing disqualifying diagnostic 47747 will now issue for Schedule C, Line 11, math error.

New Electronic filing disqualifying diagnostic 47748 will now issue for Form PPT when Part B, Line 15, has a
math error.

A new electronic filing disqualifying diagnostic 47756 will now issue when a shareholder ID is the same as
the filer's ID unless both ID's are APPLD FOR.

Schedule K-1, Line Q, check box is not available for S corporation returns.
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Schedule K-1, Line X, rounding issue is now resolved.

Arizona
When Form 285 is prepared for composite participants, Line 9, designation of representative, is now
checked.

California Electronic Filing
Diagnostic 46258 will issue when Form 592B, Part III, is missing an income type.

Connecticut
When the residency status has changed from nonresident to resident, the tax liability is no longer calculated
for the resident on Schedule CT K-1.

District of Columbia
Form D-20, Line 9, will no longer calculate the amount of other interest twice when Federal >
Income/Deductions > Interest > Nonportfolio is checked.

Florida
Form DR-405. Zeros will no longer print for Fair Market Value when zero has not been entered.

Hawaii
Composite Form N-15, Line 20, amounts are being moved back to Line 17 in order to follow state
instructions for a composite 1120S return.

Illinois
Exempt shareholders taxed as a trust will now always be treated as nonresidents.

Form IL-505-B, Extension Payment, will now include Forms IL-516-I and IL-516-B prepayments from Form
IL-1120-ST, Lines 60e and 60f.

Indiana Electronic Filing
The filing instructions will now appear in the government copy when the option has been selected to
printithe filing instructions in government copy and the return is being electronically filed.

Kentucky
Letters and Filing Instructions for Form 720-ES will now show ZIP code of 46020.

Schedule TCS will print correct print positions.

Maryland
Three digit code numbers entered at the bottom of Form 510 will now be included in the electronic file.
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Minnesota Electronic Filing
Disqualifying diagnostic 46605 will now issue when there is an amount on Form Schedule JOBZ, Line 43, and
there are no amounts entered on form M8, Line 11, and Schedule KS, Line 16.

New Hampshire
The state has changed the P.O. Box number from 637 to 1265 on Form NH-PYT, Payment Voucher.

New Jersey Electronic Filing
Diagnostic 46151 will now mention that the amount on CBT-100S, Schedule C, Line 4, must be a positive
amount for electronic filing.

Disqualifying diagnostics referring to CBT-100 and CTB-100S, Schedule J fields that apply only to returns
with a beginning date before January 1, 2014, will no longer issue.

Form CBT-100S, Page 1, Line 12, Pro Rata Share of S Corp Income for nonconsenting shareholders, will now
print 0 instead of the negative number shown on Schedule K, Part VII, Line 6. This change follows form
instructions and permits returns with nonconsenting shareholders with losses to be electronically filed.

There will no longer be a PDF error caused by the length of the IRS attachment name for an optional PDF.

New York
Form IT-2658 will no longer drop the last digit of ownership percentage if less than 10% is entered.

New York City Electronic Filing
NYC extensions are now activated when Electronic Filing > General > Electronically file extension >
selecting YES, while Electronic Filing > General > Electronically file return > selecting NO.

Oregon
OR -19, Line 7, Column 1, will now display the correct amount.

Schedule K-1 additions and subtractions will now reflect the partner's average percentage when the partner
had a change of interest.

Rhode Island
Form K-1, Section I. Line 1, calculation corrected to reflect ordinary income based on Federal Schedule K-
1, Line 1.

Section 179 Expense taken in the current year is no longer reported on the Form K-1.

Texas
Cost of labor will now show on L15 Ptr statement for 05-158-A, Line 15, calculation when 1125-A, Line 3, is
included.

Virginia
Footnotes can be generated separately for Form 765 by entering code 1 on Federal > General > Notes >
Federal and State Footnotes > State/City use.
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cFiduciary (1041) Product Updates
Return to Table of Contents.

Federal
Schedule K-1. A level one diagnostic will be issued when the return has an overall capital loss and the option
to include capital gains in ordinary income has been selected.

Schedule K-1. An adjustment for net investment income, if required, will be calculated for charitable
remainder trusts or charitable unitrusts that do not chose the simplified method.

Form 4684. Casualty gain (loss) from a passthrough coded Long-term casualty - Business property will now
flow to applicable states.

Form 5227. Negative amounts entered for other income will no longer show as excluded income after they
have been netted with other income types.

Schedule K-1. Options to include capital gains as ordinary income and to distribute capital gains if
distributions exceed ordinary income cannot be used when the Schedule D reports an overall capital loss.

Form 5227. Page 7, Part I-A, Line 2b, column (a) dollar rounding will no longer cause one dollar of excluded
income to be distributed in certain instances.

Form 1041. The description for the interest income statement for special interest code 5 on the
Consolidated 1099 will now be Amortizable bond premium adj.

Form 5227. The Part 3 total on Page 7 of Form 5227 will now print on Line 7d instead of Line 7c.

The Schedule K-1 will allocate income correctly for simple trusts when there are no distributions entered for
the beneficiaries and equal percentages are to be assumed.

The Schedule K-1 will limit the capital gains portion of the distribution for simple trusts if the amount
distributed is less than accounting income and capital gains are included in ordinary income.

Form 1041. The special interest codes of 5 and 6 will net against municipal bond interest marked as income
instead of principal.

Grantor letter. Wash sales will now be presented on the Grantor Capital Gains Summary with just the basis
adjustment.

Form 7004. When using small font, fiscal year dates are fixed for Line 5a.

Form 8960
1231 gains will not be subtracted on Line 5b for a non-passive passthrough when the activity has been
designated as a Trader in Financial Instruments or Commodities.

Royalty expenses from passthroughs will no longer be included in Line 9c.

Electronic Filing
You can now create new sections for Income/Deductions > Gains and Losses > IRS 2439.

Alabama
Disqualifying diagnostic 46594 will now issue when more than five occurrences of Schedule G are present in
the return.

Distributable net income on Form AL-41, Schedule A, Line 7, will now allow negative values.

Tax Product Updates • 25



Schedule G, Lines 10-16, Grantor's Share of Deductions, will now be calculated for nonresident grantors.

Arizona
141 AZ Page 3 Schedule D, Line 9, will populate when it is a nonresident return with a nonresident
beneficiary.

Arkansas
Arkansas Schedule K-1, Line 13, will no longer double the amount of depletion.

Form AR1002F or Form AR1002NR, Type of Entity, Charitable trust box will now be checked when Basic
Data > General > Return Identification, Type of entity selected is Charitable lead trust.

Arkansas Electronic Filing
Form AR1002F or AR1002NR will no longer be rejected for electronic filing when only a business name is
entered for the beneficiary on Schedule B.

California Electronic Filing
Electronic filing diagnostic 44926, for incomplete preparer information, will no longer issue when the
customer has selected to suppress the paid preparer information on the California return.

The California filing instructions will now print in the government copy of the return when the user has
selected to print the filing instructions in the government copy.

The California transmittal letter has been updated to properly report the balance due when the return is a
refund return with underpayment penalty greater than the refund.

Connecticut
The federal return will now print with the state in the government copy.

Georgia Electronic Filing
A disqualifying diagnostic will issue for returns that have been selected for electronic filing with entity
types A, R, and U. The State of Georgia requires all electronically filed returns have the Form 501 present.
The aforementioned entity types do not produce the Form 501 and thus are not accepted electronically by
the State of Georgia.

A disqualifying diagnostic will issue when an amended return with electronic filing is selected. The State of
Georgia does not accept amended returns via electronic filing at this time.

Illinois
A copy of the Federal 1041 will attach to the IL 1041 in the government copy of the return.

Illinois Schedule D, Page 2, Column D, will pick up the total income distributed on the Schedule K-1-T in
Column B.

The ZIP code was corrected for Form IL-1041 mailing when electronic funds withdrawal is requested for
payment.

Massachusetts
MA Schedule E and F, Line 4, has been corrected to pick up tax from Form 2, Line 13.
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Minnesota
Form 2, Line 15e, nonrefundable credits will not be included in the refund.

Mississippi
Form MS 80-160, Line 1, Column 1, will not include beneficiary amount of income twice.

Missouri Electronic Filing
Electronic filing disqualifying diagnostic has been added to alert the preparer when other additions or other
subtractions are in the return without a description.

Missouri transmittals, vouchers, and forms not included in the electronic file will now be included in the
government copy of the return when electronic filing is selected for the state.

The transmittal letter for Missouri electronically filed returns will no longer refer to a form to sign, date,
and return, as no signature form is required. The taxpayer will now be advised to contact the preparer's
office.

Nebraska
The firm name will no longer duplicate on 1041-N when the firm name is entered in the federal and state
signature block in the return configuration set.

New Jersey
K-1, Part III, disposition of property will no longer include capital gains from passthroughs.

Nonresident grantor returns and resident returns with nonresident grantors will now fill NJ-1041, Line 44b.

New York
The Tax Worksheet 3 has been fixed for tax returns with taxable income greater than $1,046,350 and less
than $1,096,350.

New York Electronic Filing
Form TR-579.2 will now print the preparer's name and ERO's name, if requested.

Pennsylvania
Pennsylvania will no longer include state tax refunds in business and other nonpassive income in the resident
state letter.

Wisconsin
The Schedule OS will no longer be prepared in a Grantor return.

Tax Product Updates • 27



Estate & Gift (706/709) Product Updates
Return to Table of Contents.

Connecticut
The following preliminary Connecticut form is available for dates of death in 2015: Form CT-706/709 EXT.
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Exempt Organization (990) Product Updates
Return to Table of Contents.

Federal
The NOL supporting statement for Form 990-T, Line 31, has been expanded to allow a maximum of 20 prior
years.

Electronic Filing
Electronic filing disqualifying diagnostic 45765 for Form 3115 will no longer be issued unless the Overall
Method of Accounting is invalid on the Form 3115 Change in Accounting Method worksheet.

New York
NOL statements for Form CT-13 will be provided if there are entries on both the Unrelated Business Tax >
Form 990-T Exempt Organization Business Income Tax Return > NOL Carryovers - Basic (Obsolete) and Net
Operating Loss Carryovers for NY.
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